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Introduction
We know you are excited about publishing and selling your eBooks to readers around the world. This
document walks you through the steps to comply with industry best practices and guidelines so you can
be sure your work is ready for publication in eBook format.
It is important to read this document in its entirety. By paying close attention and following all steps as
described, you will avoid repetitive rounds of revisions and are more likely to successfully create an
eBook eligible for distribution.
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Chapter 1: Lulu and eBooks
Who is Lulu?
Lulu is a company committed to helping you sell more books and reach more readers. Whether you are
out to make your fortune, or simply share an idea, Lulu empowers authors, publishers, educators, and
businesses to bring knowledge and expertise to readers more easily than ever before. You can do-ityourself at no cost using our publishing Wizard or choose from a wide range of Lulu services for help.
Through our Internet retail site, retail partners, and global print network Lulu has created a one-stop
shop for the ultimate in publishing freedom. You pick the price, market, and medium. As a Lulu author,
you have complete control over your price and content. You earn 80% of the profit or more when your
work sells.
You are the new face of publishing and you are in control.

What are eBooks?
EBooks are electronic, downloadable books that can be accessed on an ever-growing number of
eReader and handheld devices, like the iPad, iPhone, Barnes & Noble’s NOOK, Android tablets, and
your home computer. Millions of readers purchase eBooks each day. By publishing an eBook, you can
more easily share your remarkable knowledge and ideas with readers all over the world.
Once you have read and followed these guidelines for preparing your manuscript, the Lulu EPUB
Converter can be used to create an eBook in EPUB file format. These guidelines do not guarantee
success on your first conversion attempt, but by following these instructions, your chances of success
are greatly improved.
How Do I Sell My EBook on Sites Other than Lulu.com?
As a Lulu author, your eBooks (EPUB and PDF) can be published and offered for sale in the Lulu
Marketplace at no cost to you.
Authors with bigger ambitions can assign an International Standard Book Number (ISBN) to their
eBook (EPUB) making it eligible for distribution to the iBookstore and the Barnes & Noble Nook store
in addition to the Lulu Marketplace. This option is available to authors using a free Lulu ISBN as well as
authors who choose to bring their own ISBN or purchase an ISBN directly from Lulu.
All eBooks in EPUB format that include an ISBN are automatically submitted for technical review prior
to distribution to retail partners. LULU DOES NOT PROOFREAD OR REVIEW YOUR
CONTENT; however, we must ensure your work meets the technical quality controls required by our
distribution partners. This review focuses on compliance with distribution guidelines as well as the
technical aspects of your work, such as the file size, title, description, categorization, image quality, and
table of contents functionality. For more information about eBook distribution requirements, see eBook
Retail Distribution Guidelines.
If there are any problems detected during the technical review, you will receive an email listing the areas
that require updating. Once you have addressed these issues, you may resubmit your work for a follow
up review. If your work meets all guidelines and there are no technical issues, your work will be passed
along to our retail partners who will conduct a final technical review before placing your work on their
sites.
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Chapter 2: Supported Source Files
Before we can convert your manuscript to an eBook in EPUB file format, it must be saved as a properly
formatted DOC, DOCX, RTF, or ODT file.
Microsoft Word
Lulu supports conversion of Microsoft (MS) Word DOC and DOCX files to EPUB file format. As one
of the most widely used word processing applications, MS Word is referenced throughout this guide. All
instructions within this guide are specific to the Microsoft Office Suite 2007 or later. For earlier
versions of MS Word, please reference the Help files specific to the version within which you created
your manuscript.
Rich Text Format (RTF)
Most popular word processing programs support saving your file in Rich Text Format (RTF). You can
upload an RTF file to our converter and we will convert it into an EPUB file.
Since there are many programs that support saving documents in RTF format, we cannot provide
comprehensive instructions for each editor. However, most programs include MS Word-like menus and
features, similar to those discussed within this guide. As long as your editor supports applying stylebased formatting, you can adapt the MS Word formatting instructions discussed in the following
chapters to prepare your RTF file for conversion to EPUB. Our converter will catch many common
mistakes and fix them for you or provide warnings so you can make adjustments to the RTF file to
ensure it will look great as an eBook.
What Other Word Processing Programs Can I Use?
You can use any program, editor, or online tool capable of saving your work in Rich Text Format
(RTF), as long as it supports applying RTF style sheets. This includes Google Docs, OpenOffice,
Apple’s Pages, and many others.
Beware Simple Text Editors
Bare-bones text editors like Notepad (PC) and TextEdit (Mac) do not produce RTFs with style-based
formatting and are therefore not suitable programs for use when preparing your file for conversion to
EPUB on Lulu.

Chapter 3: Format is as Important as Grammar
When creating your remarkable work, you spent endless hours writing and rewriting, ensuring your
spelling was correct, your subjects and verbs agreed, and that your work had a consistent voice. Now,
you should spend a little time making sure it is consistently formatted.
In general, word processing programs provide two methods for formatting text and paragraphs:
Direct (or Inline) Formatting:
Creating a chapter title by manually changing the font type and size of the first line in a paragraph that
otherwise uses the Normal style is an example of Direct Formatting. While the Lulu EPUB Converter
maintains this type of formatting, it cannot identify it as a new chapter. Other examples of direct
formatting include creating indents using tabs or the space bar, or inserting additional spaces between
paragraphs using the Enter key. Our converter will automatically strip direct formatting of extra spaces
(manual indents and manually entered paragraph spacing) from your document during conversion.
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Direct formatting can be used for bolding or italicizing certain words in a paragraph. If the whole
paragraph needs to be formatted uniquely, you should apply style-based formatting to the entire
paragraph as discussed below.
Style-Based Formatting:
Selecting a text and applying a defined style from a menu, such as Heading 1, is an example of StyleBased Formatting. If your editor does not have a Styles menu, it will not support applying an RTF
style sheet to your file.
TIP: Apply a style to some text in your manuscript. Does the Styles menu display the style you
applied? If yes, then your editor supports applying a style sheet to your file.
The Lulu EPUB Converter easily recognizes styles. It uses Heading styles to automatically create
page/section breaks and to auto-generate the EPUB Table of Contents (TOC) in your eBook. For more
information on how the TOC is generated see EPUB Table of Contents.
Do I Have to Use Styles?
We know many of you are groaning right now at the thought of using the Styles menu to format every
paragraph in your book. We hear you, and have provided tips for quickly applying styles in subsequent
chapters. The good news is, you only need to use a few styles and most are available out-of-the-box in
popular word processing programs. The most important thing to remember is that every chapter or
section needs to use a Heading style, so we can ensure it shows up in the EPUB TOC.

Chapter 4: Before Converting Your Manuscript to an eBook
It is important to note that eBooks are different from their print counterparts, particularly when it
comes to formatting. eBook technology continues to evolve and each device and platform displays
eBooks differently. Therefore the first rule to follow when preparing your book for conversion to an
eBook is KEEP FORMATTING SIMPLE.
The best practices for creating an eBook are summarized below. Later sections provide additional
details.
Note: In all instances you should consult the Help files included with your word processing software for
details on how to set, modify, and apply styles to your manuscript. A little bit of homework
before you attempt to convert your manuscript to an eBook will save you a lot of rework as you
move through the process.
Formatting Styles
When it comes to eBooks, the simpler your formatting the better your eBook will look on an eReader
device. As part of your preparation for converting your manuscript to EPUB format, you should
familiarize yourself with the use of Styles. In Microsoft Word 2007 and later, the styles panel is
displayed in the toolbar.

Figure 1: Styles Panel as Displayed in the Microsoft Word Toolbar
A well-formatted eBook only requires the use of the following styles, plus they are the only ones
recognized by our converter:
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•

Heading 1 (Title, Main Sections)

•

Heading 2 (Chapters or Sections)

•

Heading 3 (Subsections)

•

Normal (Paragraph or text style)

•

Direct (Inline) Formatting such as bold, italics, bullets, and numbered lists

Important Note: If you are uploading multiple files for conversion to EPUB format, such as a separate
file for each section or chapter, EACH file must include Heading 1 style on the first line (Introduction,
Chapter 1, Chapter 2, etc.), otherwise you will receive an error message during conversion. Additionally,
heading styles in EACH file must progress sequentially from Heading 1 > 2 > 3.
Fonts and Special Characters
To ensure your content displays on all eReader devices, use one of the following fonts: Times New
Roman, Arial, or Garamond. If your file contains other fonts, your eBook’s text will automatically be
converted to Times New Roman during the conversion process.
Special characters should be avoided. Generally, if a character is not on your keyboard, it may not
convert properly. If your text includes special characters, please confirm they display correctly on an
eReader device following conversion.
Page Formatting
Unlike their print counterparts, eBooks do not use page-based formatting, but rather are composed of
reflowable text that automatically adjusts based on the selected font and eReader screen size. Page
numbers, page breaks, headers, and footers do not exist in eBooks. If you leave them in your document,
the Lulu EPUB Converter will remove them.
TIP: Although page breaks are automatically removed during the conversion to EPUB file format, a
page break is inserted before each use of the Heading 1 and Heading 2 styles to indicate the
start of a new chapter or section. On an e-reader, this will make the new chapter start at the top
of the screen. This also creates a new entry in the EPUB Table of Contents that will link to the
chapter or section.
Text Alignment (Justification)
Typically, Align Text Left converts the best. Avoid using Justify Text as it does not convert well.
Spaces and Hard Returns
The Lulu EPUB Converter removes extra spaces and hard returns during file conversion.
Paragraph Separation
Proper paragraph breaks are essential for an eBook, otherwise paragraphs will bump into each other and
your readers will not clearly see where one paragraph ends and another begins. Be sure to set your
paragraph style to either block or first line indent format with additional spacing between paragraphs.
For more information on how to modify paragraph settings, see Paragraph Formats.
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Headers and Footers
Headers and footers are not supported in EPUBs and will be removed by the Lulu EPUB Converter. If
you have important content in your headers and footers, please incorporate it into the body of your
document or as a footnote or endnote.
Title and Copyright Page
A huge amount of time went into creating your remarkable work and you want people to know you
wrote it. Well, so do our retail distribution partners. As a best practice, include a title and copyright page
– the more professional it looks, the better. For more information, see Front Matter (Title, Copyright,
Table of Contents, etc.).
Indexes
The eReader’s Search function has replaced indexes in EPUBs. For example, if your reader wants to
find all occurrences of the word “Lulu”, rather than looking up page numbers in an index, they simply
type “Lulu” in the search field, and use the search results to jump directly to the relevant page.
If your manuscript contains a chapter or section with an auto-generated index (i.e. term, page number)
we recommend you remove the chapter or section. You do not, however, need to remove the index
markers in your file; we will remove them during conversion.
High-Quality Images & Cover Art
All images must be in three color RGB (red, green, blue) format. Four-color CMYK (cyan, magenta,
yellow, key black) images are NOT accepted.
During file conversion, all images will be reformatted to display in line with text above and below the
image. Each individual image cannot exceed 250 KB and image dimensions cannot exceed 2 million
pixels. During conversion, images exceeding 2 million pixels will be resized to meet this requirement,
including your marketing image. For best results, we recommend you verify all images and resize them
as necessary, using your favorite image editing software, prior to uploading your file for conversion to
EPUB format.
TIP: The number of pixels contained within an image is calculated by multiplying the pixel width and
height dimensions. For example an 8.5 x 11 inch image has the following dimensions in pixels:
612 x 792. When multiplied together, this image contains 484,704 pixels.
Text Boxes and Mathematical Formulas
eReader devices often cannot accurately display complex content such as:
1. Charts
2. Text boxes
3. Scientific or mathematic formulas
4. Embedded objects such as HTML, Smart Art, etc.
If you must include any of the above, we recommend replacing the text with a high-quality JPEG image.
Columns
Multiple columns are best left for the Greeks and Romans or your local newspaper. During conversion,
multiple columns within your uploaded files will be converted to a single column of reflowable text.
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Multimedia Files
The Lulu EPUB Converter does not support converting audio and video files embedded in your
document. You must remove these before uploading your file.
Other Roadblocks to eBook Success
After all the work you put into creating your eBook, we assume you will want to share it with as many
people as possible. If your intent is to publish your eBook on multiple retail sites to maximize your
potential income, you must also comply with retail distribution requirements. To smooth the way into
the marketplace, please review your manuscript and remove the following:
1. Advertising: Do not include advertisements in your eBook or its description.
2. Price: Do no include the retail price of your eBook on the cover, in the description, or in the
eBook itself.
3. URLs: Remove URLs from the cover, title, description, copyright, metadata – basically,
anyplace that would not be considered part of your book’s text must be free of URLs.
4. Extras: Unfortunately, eReaders that can deliver extras like a poster, CD, or little stuffed bear
have yet to be invented. If you mention extras that come with the print version of your book,
remember to remove those references from your eBook.
5. Paper: Your eBook is not intended to be printed so there is no need to mention where the book
is printed or on what paper. Likewise, if your book is intended for use as a workbook, you may
wish to remove the portions intended for interactivity before converting it to EPUB format.
6. Language: Though we hope to be able to accept additional languages in the future, we now
only accept content for retail distribution in English.
For more information about retail distribution, see eBook Retail Distribution Guidelines and Top 10
Reasons Why Your eBook Was Rejected.

Chapter 5: Configure MS Word Settings
Follow these steps to properly configure your MS Word settings.
Note: The steps described below are specific to MS Word 2007 or later versions. If you are using an
earlier version or different word processing program, refer to your software’s Help files to
complete these steps.
Save a Copy of Your File:
Open your document and click File > Save As. Give your document a new name, such as The Greatest
Book Ever Backup Copy and save. Of course you will use your own book’s title, but you get the picture.
View Formatting Marks
Click the Paragraph (or Pilcrow) button to display all
non-printing characters. When this option is selected,
you can more easily locate and correct Direct
Formatting issues such as extra tabs, spaces, and
incorrect paragraph spacing.
Figure 2: Show Formatting Marks Button
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Turn off Track Changes
Go to Review > Track Changes and set to Off. If previous changes or comments are displayed in
your document, accept the edits and switch from Markup mode to Final.
Do Not Let Word “Fix It For You”
AutoCorrect and AutoFormat features make changes to your document based on changes you make to
selected text. Deactivate these features so that they do not undo assigned formatting styles.
To deactivate AutoCorrect:
1. Click the Microsoft Office button or File in the toolbar and select Options.
2. In the Word Options box, select Proofing and click the AutoCorrect Options button:

Figure 3: Work Options > Proofing > AutoCorrect Button Location
3. Select the AutoFormat tab and deselect the four options under Apply.
4. Click the AutoFormat As You Type tab and deselect all options except Replace as you type
> “Straight quotes” with “smart quotes.” Smart, or curly quotes, give your print and eBooks
a more professional look.

Chapter 6: Format your Manuscript for Conversion
EPUB Table of Contents
* If you’ve been 'speed reading’, slow down. This chapter is critical
if you want to distribute your eBook beyond Lulu.com.
We have attempted to keep the technical details of converting your
manuscript to an EPUB to a minimum, but sometimes details can’t be
avoided and in this case details will result in a better EPUB conversion.
Throughout this guide, we reference the “EPUB Table of Contents.” In
technical terms, this refers to a component in the EPUB called the NCX
file.
Video Tutorial: How to Publish an eBook with the Best Table of
Contents
What is an NCX?
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eReading devices utilize the navigation functions built into an EPUB file to move around the eBook.
This navigation is specified in the Navigation Control file for XML (NCX). An NCX with multiple
chapters is required to distribute your eBook to our retail distribution partners. Lulu’s EPUB Figure 4:
eBook NCX (TOC)
Converter will create the NCX for you, but we need to know where each
chapter begins. Our converter does this by looking for Heading styles in your document.
Now that you know about the technology, we will simply refer to the NCX file as the EPUB Table of
Contents (TOC) from this point forward.
How is the EPUB Table of Contents Generated?
Our converter scans your document for Heading 1, Heading 2, and Heading 3 styles and creates an
entry in the EPUB Table of Contents (TOC) each time one of these styles is used. Since an electronic
TOC will be generated for your eBook, you should remove any TOC pages from your manuscript prior
to uploading it to the EPUB converter.
Note: If your manuscript includes a TOC with hyperlinks to chapters, the hyperlinks will not function
following conversion; therefore if you plan to keep the TOC pages, we suggest you remove the
hyperlinks as well as page numbers – since eBooks do not have pages in the traditional sense.
Prepare your Manuscript to Create a Perfect EPUB Table of Contents
Our retail distribution partners require you to provide a way for readers to navigate to every major
section of your eBook via the EPUB TOC. This means each chapter and section must have a
corresponding entry in the TOC.
For Example, let’s assume your book has a few main sections (Title Page, Copyright, Preface, Body,
Epilogue) and a number of chapters, some of which contain subchapters or subsections. Your EPUB
TOC will therefore consist of three levels:
1. Apply Heading 1 style to the Title and to each line containing a Section name (copyright,
prologue, etc.) or section (Part 1, Section II, etc.). Heading 1 style will always appear at the top
of the next page.
2. Apply Heading 2 style to each line containing a Chapter name or number
3. Apply Heading 3 style to each line containing a subchapter or subsection.
IMPORTANT: Lulu supports a maximum of three levels in the EPUB Table of Contents (TOC). Do
not use additional Heading styles (Heading 4, Heading 5) to denote chapter or section breaks, as these
will not generate TOC entries. Readers will not be able to navigate to these chapters and our retail
distribution partners will reject your eBook.
To prevent errors during conversion, Headings must be applied sequentially (Heading 1 > Heading 2 >
Heading 3). You may use multiples of the same headings such as this sequence 1, 1, 1, 2, 2, 3, 2, 3, 3:
however you cannot skip from 1 to 3.
TIP: If you are uploading multiple files for conversion to EPUB format, such as a separate file for
each section or chapter, EACH file must include Heading 1 style on the first line (Introduction,
Chapter 1, Chapter 2, etc.), otherwise you will receive an error message during conversion.
Additionally, heading styles in EACH file must progress sequentially from Heading 1 > 2 > 3.
One of the top 10 reasons eBooks are rejected for distribution is an incomplete table of contents.
Following the conversion of your manuscript to EPUB format, your eBook table of contents will be
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displayed. Please confirm all sections and chapters are listed. If you are missing entries, edit and reupload your manuscript file(s) before progressing to the next step in the publishing process.
Front Matter (Title, Copyright, Table of Contents, etc.)
The first pages of a book set the professional tone for your readers and will make or break your ability
to achieve distribution through our retail distribution partners.
Title Page:
The very first thing you want your reader to see is your title – not blank spaces before your title.
Therefore, your title must be on the very first line of the manuscript and be formatted as Heading 1
style. This allows the Lulu EPUB converter to correctly identify and display your book’s title in the
eBook TOC. If you aren’t a big fan of the way the Heading 1 style looks, you can modify the style or
create a new one.
If your title is not on the first line (i.e. hard returns precede it), the name you entered in the manuscript’s
properties file will display in the TOC. If the properties filename is blank, the converter will display the
title as “untitled” in the TOC. Both of these situations will result in your eBook being rejected for
distribution.
Copyright:
On the Copyright page, you should include the year the work was created followed by your book’s
ISBN (International Standardized Book Number). If your book does not have an ISBN, Lulu can assign
one for you in the Wizard. You will need to copy the ISBN we assign, and update your manuscript by
adding this ISBN to your copyright page before proceeding to the Upload step in the Wizard. You will
also want to reference the copyright license, which lets readers know what they can and cannot do with
your work. For more information about copyright licenses, see How do I set a Copyright License for my
Work?
Here is the Title and Copyright page for this guide. You can adapt this text for your own use or use the
format from any published book on your bookshelf as a template. Just be sure to replace the pertinent
information with information specific to your work:

Lulu: Complete eBook Creator Guide

Lulu Complete eBook Creator Guide
Fourth Edition
Copyright © 2012 Your Name / Company Goes Here
All rights reserved.
ISBN: XXX-X-XXX-XXXXX-X (Your ISBN Number Goes Here)
This work is licensed under the Creative
Commons Attribution-ShareAlike 3.0 Unported
License. To view a copy of this license, visit
http://creativecommons.org/licenses/by-nc/2.5/
or send a letter to:
Creative Commons
171 Second Street, Suite 300
San Francisco, California 94105
USA
http://www.lulu.com

Traditional Table of Contents
EBooks use chapter links to navigate to specific sections or chapters; therefore, it is not necessary to
include a traditional Table of Contents (TOC) in your eBook. For more information, see EPUB Table
of Contents. If for aesthetic purposes you choose to include a TOC, you should remove the page
numbers since eBooks do not have pages and the numbers will be misleading to your readers.
Paragraph Formats
To make your book an enjoyable reading experience, you should choose a single method for visually
separating paragraphs. There are two common paragraph formats: first line indent or block
paragraphs. Most works of fiction use first line indent while most non-fiction works use block paragraph
style. Of course, there are exceptions, so you must choose what works best for your book.
Whatever style you choose, do not mix the two and do not use the Return key to add extra spaces
between paragraphs. The EPUB converter will remove extra spaces, resulting in your eBook’s
paragraphs having no separation.
Example: First Line Indent Paragraph Style
“Mr. Heathcliff?” I said.
A nod was the answer.
“Mr. Lockwood, your new tenant, sir. I do myself the honour of calling as soon as possible after my
arrival, to express hope that I have not inconvenienced you by my perseverance in soliciting the
occupation of Thrushcross Grange: I heard yesterday you had had some thoughts—“
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The ‘walk in’ was uttered with closed teeth, and expressed the sentiment, ‘Go to the Deuce:’ even
the gate over which he leant manifested no sympathising movement to the words; and I think that
circumstance determined me to accept the invitation: I felt interested in a man who seemed more
exaggeratedly reserved than myself.
Example: Block Paragraph Style
Lulu's forums help build a strong community of creators by fostering discussion and sharing
information. Messages posted by Lulu community members are solely the opinion and responsibility of
the person posting the message. All users posting to the Lulu forums must read this Forum Posting
Policy.
Posting to the forums constitutes your agreement to the terms outlined in this Forum Posting Policy.
For more information on Lulu's terms of service, please also see our Member Agreement.
Please treat all Community members with respect. As volunteers who are helping other users in the Lulu
forums, all members and moderators deserve your courtesy as much as we feel you deserve theirs. While
we're the first to admit we're not perfect, we strive to be impartial and conduct ourselves in the fairest
manner as possible for all.
Set Your Paragraph Style
Once you decide how you want your paragraphs to look, modify the Normal text style to automatically
apply these settings to your paragraphs.
To modify a style:
1. In the Styles menu, right-click on Normal.
2. Select Modify from the resulting list.

Figure 5: Modify an Existing Style
3. Click the Modify button (bottom left corner of the Modify Style window) and choose
Paragraph from the resulting list.
4. For Block Paragraphs
5. Under Indentation, select 0 inches for both Left and Right margins
6. Select None from the Special dropdown list.
7. Under Spacing enter 0pt in the Above field and your choice for spacing in the Below field. Try
to keep your paragraph spacing between 4 and 10 pts.
8. The Preview panel displays sample text as it will appear in your file.
9. Click OK to accept your modifications.
10. For First Line Indent Paragraphs
11. Under Indentation, select First Line from the Special dropdown list.
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12. Enter the amount of indentation you prefer in the By field. You should keep your indent
between .25 and .3 inches.
13. Under Spacing, enter 0pt in the Before and After fields.
14. The Preview panel displays sample text as it will appear in your file.
15. Click OK to accept your modifications.
Fonts, Images, Hyperlinks, and Footnotes
Fonts
There are times when you want to add a little “flair” to your work, so now’s your chance. The Lulu
EPUB Converter will convert most formatting like bold, italic, and strikethrough. However, symbols do
not always convert properly and may display as other characters, so you will want to double-check them
after conversion.
Always use Times New Roman, Arial, or Garamond fonts when creating your document. Any other
fonts detected during conversion will be converted to Times New Roman. When applying styles to your
document, be sure to change the default font to a supported font. You must do this for each style used
in your document.
Tip: If you try selecting all text and applying one of the supported fonts, you may inadvertently leave
unsupported fonts in your file. The Lulu EPUB Converter will change these to a supported font
for you, but if you want to apply them yourself, see the next section.
Problem:
When you select all of your text and apply Arial, all paragraphs using the Heading 1 style ignore the
selection and remain as the default font (i.e. “Cambria”).
Solution:
There may be paragraphs in your file that use a hard-coded default Style such as Cambria or another
unsupported font. Ensure all Styles used in your document are set to a supported font.
To modify font styles:
1. Right-click on the Style in the styles menu
and select Modify.
2. Under Formatting, select a supported font
(Arial, Times New Roman, or Garamond).
3. Check Automatically update to update all
instances of this style in your manuscript to
the new setting.
4. Click OK.
5. Repeat for all other styles in your manuscript
(i.e. Normal, Heading 2, Heading 3, etc.).

Figure 6: Modify Heading 1 Style Window
Images
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Blurry images are one of the most common rejection reasons from our retail distribution partners. If
your document contains images, you may need to make a few adjustments in order for them to convert
properly. We accept the most commonly used image formats: JPG, GIF, PNG. Images require a delicate
balancing act since your image must have a resolution high enough to be clear and crisp, but not so high
that it is too large. Try to keep the resolution on your images between 96 - 150 DPI. You will also want
to keep your image size around 500 x 500 pixels or less. You can adjust image resolution and DPI in any
image-editing program.
Note: Some retail distribution outlets do not accept images above 2 million pixels. To prevent rejection,
we suggest you make adjustments to images prior to conversion to EPUB format.
To add an image to your manuscript:
1. Place your cursor in the location at which you would like your image to appear.
2. From the toolbar, click Insert > Picture. Be sure you are inserting the image, not linking to it.
3. The selected image displays in the cursor location.
4. Click on the image and select Format Image.
5. Choose the In line with text option.
6. Click Save.
7. Click on the image and click Center in the toolbar.
Note: The Lulu EPUB Converter automatically formats images in line with text regardless of the
settings you apply prior to conversion.
Create New Styles
Once you become accustomed to using styles, you may discover that creating a new style may be easier
than repeatedly applying direct (inline) formatting.
To create a new style:
1. From the Styles box click on the Manage
Styles icon (at the lower right of the Style
menu).
2. Select the New button.
3. Enter a descriptive name such as Copyright
Text, Hanging Indent, Note Format, Figure
Title, etc.
4. If your new style is similar to an existing style,
choose the Style Type, Based on, and Style
for following paragraph settings from the
dropdown boxes.
5. Choose the Default Justification (left,
centered, right, etc.) for the new style. For
EPUB conversion, Lulu recommends using
Left justification.
6. Add or remove paragraph spacing as necessary.
Figure 7: Create a New Style Window
7. The Preview panel displays an example of how the style will appear when applied to text.
8. Click OK.
As always, look over your converted EPUB to ensure it looks the way you want. Make adjustments as
necessary.
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Hyperlinks
A hyperlink can be a nice addition to an eBook when read on a device like the iPad or Nook Tablet. It
can also be a bit annoying if a reader accidently clicks a hyperlink and suddenly finds they have
unintentionally navigated to an unexpected webpage. Keep in mind that on most eReader devices, when
a reader clicks a hyperlink, the eReader application closes and a browser window opens. Your reader
may get distracted by the Internet and never come back to your book! Therefore, you should be
judicious in your use of hyperlinks.
To add a hyperlink:
1. Highlight the text to which you
want to add a hyperlink.
2. Right click on the text and select
Hyperlink.
3. In the Address field, enter the
URL for the website (for example
http://www.lulu.com). Be sure to
include the http:// otherwise the
link will not work.
Figure 8: Add a Hyperlink
If you want an internal link to another chapter or section within the EPUB, select the Place in this
Document option from the Link to panel and link to a previously created bookmark or heading.
TIP: Be careful with internal links. Many eReaders do not include a back button.
There are some restrictions on the URL addresses and sites that can be hyperlinked from your EPUB.
Links cannot be to advertisements. You cannot link to sites selling books. You can, however, link to
your Blog or personal website(s).
Footnotes and Endnotes
Not to be confused with headers and
footers, EPUBs do support footnotes
and endnotes.
To add endnotes or footnotes:
1. From the toolbar, click Insert >
Footnote.
2. In the popup window choose
Footnote or Endnote and
select the formatting options.
3. Click OK.
Figure 9: Insert Footnote Window
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Chapter 7: Upload your Manuscript for Conversion
Creating an EPUB from a Word document can sometimes be a process of trial and error. If you get an
error message, take a deep breath and read this section, we’ll help get you through it. Taking the time to
get this right now will mean a better result later. The diagram below describes the process you should
use to create your EPUB with the Lulu EPUB Converter.

Figure 10: EPUB Conversion Process Diagram
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How Does the EPUB Conversion Process Work?
When you upload your manuscript in DOC, DOCX, RTF, or ODT file format to the eBook Wizard,
the Lulu EPUB Converter will attempt to convert it into EPUB format. As part of the process, we
automatically find and fix many common formatting errors. Sometimes, however, we find errors that
require you to make changes to the original file and re-upload it. The EPUB Converter will display a
message listing what you need to do next. There are three (3) potential outcomes:
Success, no issues found!
A publish-ready EPUB was created, no formatting issues were found. You obviously know what you are
doing, or you are very good at following instructions! Download and review your EPUB to ensure you
are happy with the result. Proceed to the next step in the eBook Wizard.
Success, but we fixed some issues for you.
We were able to create an EPUB, but you should download and review the results to ensure you are
comfortable with the changes we had to make. Take note of the messages detailing what was fixed
before navigating away from this screen.
Failure, we could not convert your file.
We found some problems in your source file that we could not automatically correct. Take note of the
errors we found, fix them, and re-upload your file. We also list any issues we fixed for you so you can
review these changes while reformatting. Compare the list against the possible error messages listed in
this guide for further instructions.

Chapter 8: Troubleshoot Conversion Errors
Things We Could Not Fix During Conversion
There are some formatting issues we cannot automatically fix during conversion that result in errors.
You will need to fix them in your manuscript file, and upload again. See below for a list of common
error messages and possible solutions.
Error: Text boxes were found in the document and must be removed.
Fix: Each text box must be removed from your document. Important text should be removed from
the text box and added to the relevant section of the manuscript.
Note: You can also use specialized styles or create images to achieve a similar look. This error message
may also display if your manuscript included headers or footers with page numbers since MS
Word uses text boxes to display page numbers. So, when you remove your headers and footers,
be sure to also remove page numbers.
Error: Hmmm, we tried to convert your file to an EPUB for you as you requested, but we experienced
some issues.
Fix: 99.99% of the time this error message is generated when Heading styles are not applied
sequentially. For example, your title is Heading 1, but your Copyright page is set to Heading 3. Confirm
your headings are applied properly and re-upload your file.
TIP: A simple way to view your Headings in MS Word is to use the Document Map pane. This pane
displays all the Heading styles within your document.
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Figure 11: Document Map Pane Displaying Heading Styles in this Document
Things We Fixed During Conversion
We automatically find and fix many common formatting issues. If the Lulu EPUB Converter returns any
of the messages below, it means we successfully generated an EPUB for you. Please download and
review your EPUB to ensure you are satisfied with the changes we made. If not, you can reformat your
original manuscript file and re-upload it until you are satisfied with the result.
Message: We removed multiple blank lines found in succession.
What we did: You added extra space between paragraphs using the Return key. We have removed the
extra returns. Download and review the EPUB file. If you are not satisfied with the results, change your
paragraph style or add Headings to create space.
Message: We removed whitespace from the beginning of improperly formatted paragraphs.
What we did: If you used the Tab key and/or Space bar instead of creating a paragraph style with first
line indents, we changed the tabs and/or spaces to indents for those paragraphs. Download and review
the EPUB file. If you are not satisfied with the results, remove the spaces and/or tabs and apply first
line indent paragraph style.
Message: We converted all unsupported fonts to Times New Roman. Times New Roman, Arial, and
Garamond are the only fonts supported in the EPUB format.
What we did: When we converted your document to EPUB we changed the font to Times New
Roman. If you want a different font, change the font in your document to either Arial or Garamond and
re-upload it for conversion. See Modifying Styles for more information on how to quickly update fonts.
Message: We have removed all headers and/or footers from your document.
What we did: Headers and footers are not supported in the EPUB format so we removed them during
conversion. Download and review the EPUB file. If you are not satisfied with the results, remove the
headers and footers from your original manuscript and re-upload the file for conversion.
TIP: Some of Word’s default headers and footers include text boxes for the text and page numbers.
We automatically strip headers and footers, but we cannot strip out the text boxes embedded in
them. A simple method for detecting hidden text boxes is to create a text box on the title page of
your manuscript, select it and hit the Tab button. This automatically locates and highlights the
next text box in your document. Click Delete and repeat until you return to the title page.
Message: Your file “XXX” uses optional hyphens, which is currently not supported. We have
converted the file, but it may contain formatting errors. Please review the result.
What we did: We removed all optional hyphens from your document. This formatting is applicable for
print books that do not have reflowable text. You can safely ignore this warning as it will not affect the
formatting of your EPUB.
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Warning: We found an unusually high number of chapters, suggesting you may have improper chapter
divisions in your document. Please ensure your chapter divisions are correct.
What we did: The Lulu EPUB Converter assumes that Heading styles are chapters. If you have
multiple headings in a row, the converter will see them as separate chapters and will insert each into the
EPUB table of contents (TOC). This will break up the page and may look bad in the EPUB. Download
and review the EPUB TOC and make sure we correctly identified the chapters. If not, inspect your use
of Heading styles, make adjustments as necessary, and re-upload for conversion.
Important: Failure to address this warning may result in your eBook being rejected by our retail
distribution partners.
Warning: We found an unusually low number of chapters, suggesting you may have improper chapter
divisions in your document. Please ensure your chapter divisions are correct.
What we did: The Lulu EPUB Converter uses headings to populate the EPUB Table of Contents
(TOC). Our retail distribution partners require that the EPUB TOC include an entry for each chapter
and section in your eBook. Review the EPUB TOC and make sure we correctly identified the chapters.
If not, inspect your use of Heading styles, make adjustments as necessary, and re-upload for conversion.
Important: Failure to address this warning may result in your eBook being rejected by our retail
distribution partners.

Chapter 9: Preview Your Converted EPUB
Following the conversion of your manuscript to EPUB format, your eBook table of contents will be
displayed. Please confirm all sections and chapters are listed. If you are missing entries, edit and reupload your manuscript file(s) before progressing to the next step in the publishing process.
You may also see a page listing errors encountered or a list of changes made to your manuscript during
conversion. From here, you can download your EPUB file:
Note: Downloading your file at this step may show an incorrect title. Don’t worry! Once you publish
your file, we will use the title you provided in the first step of the eBook Wizard.
Ways of Looking at an EPUB
Every device and EPUB reader will display your eBook slightly differently since readers can tailor their
reading experience by changing font types, font sizes, and even the page background color or theme.
The look and feel of your file will vary depending on which EPUB reader is used. Don’t get hung up on
this; the important thing here is to ensure there are no major issues in the CONTENT of the file
(missing sections, blacked out images, missing entries in the EPUB Table of Contents).
To open and review the file, you may need to install an EPUB reader or plug-in. If you don’t have one,
there are many free tools available to help.
•
•

From Adobe: Adobe Digital Editions
For Firefox users: download this plugin to preview directly in your browser

Tip: To see your file exactly as readers will see it, you must load your EPUB onto an e-reader device.
I Have an EPUB Editor. Can I Edit and Re-upload the EPUB File?
Do NOT attempt to fix and re-upload the EPUB file we generated for you. Many EPUB editors
introduce “helpful” elements that will cause errors in the eBook Wizard. We strongly encourage you to
fix your source file, re-upload, and let Lulu handle the conversion. This will produce the cleanest EPUB.
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Chapter 10: Final Check
Before you release your remarkable new work to your eager fans, take one last look to make sure you
have done all of the following:
•

You have all the necessary components to publish and distribute your eBook – a properly
formatted EPUB, an ISBN, cover art, and complete and accurate metadata.

•

You have tested your EPUB to make sure it opens, every link works, and the images are top
quality.

•

If you plan to sell your eBook through our retail distribution partners, please review our
eBook retail distribution requirements and ensure your content meets all requirements.

•

Once we receive your eBook, our Quality Assurance team will confirm your work meets all
distribution requirements. If it does, your title will be passed along to our retail partners, who
will reconfirm your work meets their standards. When your work passes this final inspection,
it will be queued for release on the retailer’s site. Be prepared for this step by reviewing the
list of Top 10 Reasons your eBook was Rejected.

Now take a deep breath, and pat yourself on the back. You’ve taken a big step towards selling more
books and reaching more readers than ever before! We look forward to your continued success on
Lulu.com and our network of retail channels.
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